LENESANS Release Note

RZ/T2L Group
Encoder I/F BiSS-C sample program

Summary
This document describes the RZ/T2L Encoder I/F BiSS sample program package.

For BiSS Interface communication protocol specifications and encoder specifications, contact manufacturer
of each encoder to obtain it.

Functionality Checked Device
RZ/T2L CPU Board (RTK9RZT2L0OC00000BJ)
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RZ/T2L Group

Encoder I/F BiSS-C sample program

1.

Package Contents

This package contains the following contents.
The BiSS-C encoder interface of the RZ/T2L supports up to 2 axes, but the sample program supports only 1
axis. To use with 2 axes, modify the sample program to support 2 axes.

1.1 Software
e Source code
No. Name Version
1 RZ/T2L BiSS-C sample program 1.0
1.2 Document
No. Document name Version File name
1 RZ/T2L Group Encoder I/F BiSS-C 1.10 (j) r11an0723jj0110-rzt2l.pdf
sample program Release Note (e) r11an0723ej0110-rzt2l.pdf (this document)
2 RZ/T2L Group BiSS-C sample 1.00 (j) r11an0722jj0100-rzt2I-biss.pdf
program Application Note (e) r11an0722€j0100-rzt2I-biss.pdf

R11AN0723EJ0110 Rev.1.10
May 31.23

Page 2 of 11

RENESAS




RZ/T2L Group Encoder I/F BiSS-C sample program

2. File Structure

The file structure and contents of this package are detailed below.
Top
— r11an0723jj0110-rzt2l.pdf
F— r11an0723ej0110-rzt2l.pdf
L— workspace
— Software
| — iccarm
| | L— RZ_T2L_biss.zip : RZ/T2L BiSS sample program set (IAR)
| = gcc
| L— RZ_T2L_biss.zip : RZ/T2L BiSS sample program set (e2 studio)
L— Documents
— r11an0722jj0100-rzt2l-biss.pdf
L— r11an0722€j0100-rzt2l-biss.pdf

The file structure of the RZ_T2L_biss.zip is shown below.

Top folder
— configuration.xml : FSP Configuration data
— R9A07G074M04GBG.pincfg : RZ/T2L Pin Configuration data
— ( Environment File Depending on Build Tool )
L— src
— hal_entry.c : BiSS-C sample program
— ssi_main.c : BiSS-C sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
L— drv
L— biss
— iodefine_biss.h : BiSS register definition file
F— r_biss_rzt2.c : BiSS driver file
— r_biss_rzt2_config.h : BiSS driver file
F— r_biss_rzt2_dat.h : BiSS driver file
F— r_biss_rzt2_if.h : BiSS driver file
— r_biss_rzt2 private.h : BiSS driver file
L— bissc
F— r_bissc_rzt2.c : BiSS-C driver file
— r_bissc_rzt2_config.h : BiSS-C driver file
— r_bissc_rzt2_if.h : BiSS-C driver file
L— r_bissc_rzt2_private.n  : BiSS-C driver file
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RZ/T2L Group Encoder I/F BiSS-C sample program

3. About BiSS Sample Program

This section contains information necessary to use the complete set of BiSS sample program.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and BiSS, BiSS-C driver is shown in following table. This table
does not include memory size used by Flexible Software Package or C language libraries of the compiler.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
BiSS, BiSS-C driver Code 3.6 3.0
Data (with initial value) 0.0 0.0
Data (without initial value) 0.1 0.1
Constant Data 0.1 0.1
Sample program Code 3.0 3.4
Data (with initial value) 0.0 0.0
Data (without initial value) 0.6 0.6
Constant Data 1.5 1.5
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RZ/T2L Group Encoder I/F BiSS-C sample program

3.2 Hardware Information
3.2.1 Device
RzZ/T2L

3.2.2 Target Board
(1) Board name

RZ/T2L CPU Board (RTKORZT2L0C00000BJ)

(2) Setting of CPU Board
The target board configuration is as follows.
SW4-1: ON, SW4-2: ON, SW4-3: OFF
SW4-4: OFF
SW4-5: ON
SW4-6: ON
SW4-7: OFF
SW5-6: OFF, SW5-7: ON, SW5-8: OFF, SW5-9: OFF
SWe6-1: OFF, SW6-2: ON, SW6-3: OFF, SW6-4: OFF

(3) Used pin

The correspondence between the pin used as the encoder I/F and the pin header of the target board is as
follows.

Channel Pin name Pin header Input/Output Description
BiSS0O ENCIFDIO (SLO) J26 #2 input Sensor Data/Control Data input pin
ENCIFCKO (MAQ) J26 #3 output Clock/Control Data output pin
BiSS1 ENCIFDI1 (SL1) CN1 #5 input Sensor Data/Control Data input pin
ENCIFCK1 (MA1) CN1 #2 output Clock/Control Data output pin
R11AN0723EJ0110 Rev.1.10 Page 5 of 11
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RZ/T2L Group

Encoder I/F BiSS-C sample program

3.3 Procedures on Development Environments

3.3.1

Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN16.
The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous Serial transmit/receive
send / receiving order LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM: IAR Systems

(1)

Build environment

IAR Embedded Workbench for ARM v9.32.1
RENESAS RZ/T2 Flexible Software Package v1.2.0

()

Execution environment ICE

IAR I-jet

®)

Build Procedure for Sample Programs

The build procedure for the sample program is as follows.

1

a b wN

Note:

Copy the extracted source files to the desired location.

Activate EWARM.

Select [File] menu -> [Open Workspace].
Open the extracted source file RZ_T2L biss.eww.5
Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text RZ Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml

Initial directory

$PROJ_DIRS$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
You can also start the FSP Smart Configurator directly from the command prompt by specifying the

folder where it is installed.
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RZ/T2L Group Encoder I/F BiSS-C sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

!E C¥1_Prog¥Work¥Work_C¥Work_EWA_932¥RZT2L_BiSS_release_chk - FSP Smart Configurator - O * |
File Window Help Run
[RZT2L_BiSS_release_chk] FSP Configuration el FSP Visualization =
o - ba
Summary Generate Project Content L]
i N
Project Summary i
Board: RSK+RZT2L (RAM execution without flash memory)
Device: RYADTGO74MO4GBG
Toolchain Version: 9.3.1 20200408 s B B
FSP Version: 120 ‘ e ) e B
Project Type: Flat 54 - o o .
Location: C:1_ProgWork/Work_CMWork_EWA_932/RZT2L_BiSS_release_chk o4 a0 ol ok o
Selected software components T e
Am CMSIS Version 5 - Core (R) v5.7.0+renesas. 1 -
Board Support Package Common Files v1.2.0 - e
Event Link Controller v120 . i
General PWM Timer v1.2.0 hdlil
§ . - e
Summary | BSP| Clocks Pins Interrupts| Event Links| Stacks' Components r A
Properties 2 Problems u = 0 OcConsole ¥ e
Property Value No consoles to display at this time.

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug¥Exe¥RZ_T2L _biss.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Execute].
2 Select [Debug] menu -> [Execute].

(5) Execution result of the sample program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2L Group BiSS-C Sample Program Application Note.

7 COM4 - Tera Term VT = O X

JUF) |EE Y RO-JL0) DAVEIW)  ALT(H)
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RZ/T2L Group Encoder I/F BiSS-C sample program

3.3.3 e?studio: RENESAS
(1) Build environment

RENESAS e? studio 2023-01
GNU ARM Embedded Toolchain 9.3.1.20200408
RENESAS RZ/T2L Flexible Software Package v1.2.0
(2) Execution environment ICE
SEGGER J-Link
(3) Build procedure of the sample program
The procedure for building the sample program is as follows.

1 Copy the expanded source file to any location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e2studio to open it.

Q RZT2L_BiSS_release_chk - € studio — (] * ‘
File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

& | % || ® | % Debug [ RZ_T2L_biss.elf g & -29 ™4~

o it r Qv -0 v Q | |[Ecsces

{1 Project Explorer < Lo = O ||G Outline X =0 s

= There is no active editor that | &
w £ RZ_T2L biss| provides an outline.

n) Includes

2 configurationxml

R0 GO AMOAGE G.pinclg
RZ_T2L_biss.elfjlink
X| RZ_T2L _bisselflaunch

* problems X [ Console [C] Properties @ A7—k-F5H- L} A9-F- 72271 = 0
0 errors, 9 wamnings, 0 others
Description Resource Path Location Type
% Wamnings (9 items)
< >
0 items selected
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Encoder I/F BiSS-C sample program

7 Click Generate Project Content in the FSP Configuration pane of e2studio.
The rzt, rzt_cfg, rzt_gen, script and .settings folders are generated.

8 RZT2L_BiSS_release_chk - RZ_T2L_biss/configuration.xm - & studie

File Edit Source Refactor Navigate Search Project RenesasViews Run Window
X |

@ | 1 Debug €7 RZ_T2L bisself

v - v|r®

L Project Explorer X = B ||{} [Rz_T2L biss] FSP Configuration X

v |5 RZ_T2L biss [Debug
nl! Includes
5 src

Summary

Project Summary

4% configurationxml

RIAD7GOT4MO4GEG.pincfg Board:
RZ_T2L biss.elfjlink Davice: ROAOTGO74MO4GBG
ol Toolchain: GCC for Renesas RZ
X| RZ_T2L bisselflaunch Ttk
Version: 9.3.1.20200408
FSP Version: 120
Project Type:  Flat
Location:

Selected software components
Arm CMSIS Version 5 - Core (R)

Event Link Controlier
General PWM Timer

|- (8
Support

0 errors, 9 warnings, 53 others
Description

% Warmnings (9 items)

i Infos (53 items)

configurationxml - RZ_T2L_biss

8 Select [Project] menu -> [Build All]

Help

B-{-ads o

- o x

4 - o Q- W
Q Geic/ces
5 Outline X =0 s

There is no active editor that provides
an outline.

Generate Project Content

A

RENESAS

RSK+RZT2L (RAM execution without flash memory)

Board Support Package Common Files

Summary | BSP| Clocks | Pins| Interrupts | Event Links | Stacks Components

* ! Problems X | B Console [] Properties| @ 23—k-7394- 0} 29-F-v=17)L

Resource Path

The Debug¥RZ_T2L biss.elf file is generated.

C:/1_Prog/Work/Work_C/Work_E2S_RZ.. ZT2L_BiSS_release_chk/RZ_T2L_biss =~

v5.7.0+renesas. 1

vi20
vizo
v120

Location

Type
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RZ/T2L Group Encoder I/F BiSS-C sample program

(4) Execution procedure of the sample program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.

3 Select the cpsr register from the Registers tab and set bit5 to 0 (Ox1fa to Ox1da).

&) RZT2L _BiSS_release_chk - RZ_T2L_biss/rzt/fsp/src/bsp/cmsis/Device/RENESAS/Source/startup.c - e studio m] *
File Edit Source Refactor MNawigate Search Project Renesas Views Run Window Help
]| t5 @ | 15 Debug 7 RZ_T2L_biss.elf - P~-% "B 9 >S4~
g LIPS S x i XN Q- - % - Q&R - - - B P
B2 C/C++ 15 Debug
5 Debug X i+ el [RZ_T2L biss] FSP Configuration €] startupc X S 0O||lm=viSre®t X | S Ols
w (€5 RZ_T2L_biss.elf [Renesas GDB Hard| & __asm volatile ( - - % A
v i RZ_T2L_bisself [1] [cores: 0] "set_hactlr: s
~ @ Thread #1 1 (single core) [cor " MOW r@, X[bsp_hactlr_bit PC:0/BOA:0/4 | B | T
gt b Lisbaard " MONT r@, # 5 1
= system_init{) at startup.c:3t _ el “;\' vh, * 547 i o o
— ICR pl5, #4, r@, cl, c8, I \ﬁ*l—j.’—“-‘
wa arm-none-eabi-gdb (7.8.2 ::[bsp_hactlr bit 1] "i" (BSP | 2 / _‘v_y:
5 Renesas GDB server (Host) ] 8 F-2AFE
__asm volatile ( [ v
Piot- o M €0 saan. A bt
MRC p1s, #4, r1, €1, a1 v || € 2
< > Jovivr RESnETYIL-F
& Console Registers < | |* Problems| @ 27—t 737%-| @ Debugger Console| [J Memory =Y
Name Value Description £
sp 0x0
Ir 0x100013
B Luioonon
I cpsr Ox1da l
v
< >
Mame : cpsr ~
Hex:@xlda s
< >

4  Click [Run] menu -> [Resume] to run the sample program

(5) Execution result of the sample program

Run the sample program and enter commands in the terminal software window. For commands, see
4.11.7 console commands in the RZ/T2L Group BiSS-C Sample Program Application Note.

1 COM4 - Tera Term VT

= O X
D42 K9 (W)

AL T(H)

) RE([E 1Y +O-JK0)
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Revision History

Description
Rev. Date Page Summary

0.80 Dec.28.22 - First Edition issued.

1.00 Mar.31.23 - Change description by using RZ/T2 FSP v1.2.0
(Version number of documents, target board name, build
environment, and figures are updated.)

1.10 May 31.23 1,4 Appended section 3.1.2 for memory size information.

2,3 Updated the release note version number.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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